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This document serves as a guide for the basic configuration procedures required for integration of DYNAMIXEL 
X-Series actuators with the Weigl ProCommander® AX and ConductorPro™ timeline-based show creation 
software via the Windows platform. These instructions particularly pertain to animatronic actuation and show 
creation/deployment with a focus on quickly getting DYNAMIXEL X-Series actuators up and running on your 
ConductorPro™ and Weigl system, with the least amount of configuration where applicable. 

It should be noted the general process outlined here would apply to other DYNAMIXEL series actuators as well, 
with the following notes:

•  Not all DYNAMIXEL models utilize the same control table. For example, XL430 models and XC430 models 
belong to X-series, but lack the current-control features and operating modes offered by XM and XH models. 
Please refer to the appropriate documentation for your model of  DYNAMIXEL via the ROBOTIS website 
emanuals.

• Another series of DYNAMIXEL which has been very popular for SFX/animatronics is the DYNAMIXEL P-series 
(industrialized models). These actuators have drastically different firmware addresses. Refer to the control table 
for your model of DYNAMIXEL via the ROBOTIS website emanuals.

While this guide includes all necessary steps, basic knowledge of the Weigl ProCommander® hardware, as well 
as ConductorPro™ and Hardware Configurator software are assumed. For more information and support, please 
refer to additional Weigl and/or ROBOTIS documentation as required.

WHAT YOU’LL NEED                                                                                                                                                                                   
The following items are utilized within this guide:

Software
 • Windows Computer with the following software:
  • DYNAMIXEL Wizard 2.0 Windows version (free download)
  • Weigl Hardware Configurator 1.25 or higher Windows version (free download)
  • ConductorPro™ version 2020.1.27.5859 or higher (purchased from Weigl with accompanying 
     dongle)

Hardware
 • ProCommander® AX with firmware 2.75 or higher
 • ROBOTIS DYNAMIXEL  Starter Set (U2D2 USB converter, U2D2 Power Hub, 12V AC adapter)
 • DYNAMIXEL XM430-W210-R actuator
 • Industrial IX Type A to RJ45 cable for connecting the ProCommander® AX to actuator
 • Standard ethernet cable for connecting your computer to the ProCommander® AX
 • MicroSD card reader for deployment of show files to ProCommander® AX
 • MicroSD card for ProCommander® show deployment

Optional 
 • Windows compatible analog input device - joystick, slider board, etc. for show programming
 • IX to RJ45 terminal block for ease of ProCommander® IX connector wiring

OVERVIEW

http://emanual.robotis.com/docs/en/dxl/x/
http://emanual.robotis.com/docs/en/dxl/x/
http://emanual.robotis.com/docs/en/dxl/p/
http://www.robotis.com/service/download.php?no=1670
http://faq.weigl.support/support/solutions/articles/5000290557-weigl-configurator
https://www.weiglcontrols.com/products/conductorpro/
https://www.weiglcontrols.com/products/procommander-x-series/
http://faq.weigl.support/support/solutions/folders/5000088669
https://www.robotis.us/dynamixel-starter-set-us/
http://www.robotis.us/dynamixel-xm430-w210-r/
https://www.mouser.com/ProductDetail/HARTING/09482612749015?qs=Slt%252B5btlScTRUGbJZZ%2F%252B%252Bg%3D%3D
https://www.asi-ez.com/member/~16001.asp
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THE PROCESS                                                                                                                                                                                    
The process outlined in this guide can be summarized into 5 main steps as follows:

1. INITIAL DYNAMIXEL 
ACTUATOR

CONFIGURATION

2. CONNECTING 
ACTUATOR TO 

PROCOMMANDER® AX

3. WEIGL 
CONFIGURATION

4. SHOW
PROGRAMMING

5. SHOW
DEPLOYMENT

Additional information is also included in this guide for custom Control.INI commands to monitor and change 
settings of the DYNAMIXEL actuator directly via Weigl ProCommander® devices. 
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1.1 DYNAMIXEL STARTER KIT ASSEMBLY AND CONNECTIONS
1. Assemble four(4) plastic supporters at each corner of the U2D2 Power Hub Board as shown below.

NOTE: Various pins are exposed behind the board. We recommend users to assemble and use the included 
supports with the board as shown above.

2. Use plastic rivets to mount U2D2 on the U2D2 Power Hub Board.

1. INITIAL DYNAMIXEL ACTUATOR CONFIGURATION
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3. Connect U2D2 and U2D2 Power Hub Board with a 4P cable (For future reference, both 3P and 4P cables can 
be connected at the same time as shown below).

4P cable

4. Connect an additional 4P cable to the U2D2 Power Hub Board and to the DYNAMIXEL XM430-W210-R 
actuator. 
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5. Connect the 12V power supply to the U2D2 Power Hub Board via ONE of the three possible options.

DANGER : 
• Do NOT use multiple power inputs at the same time. Select ONLY one of the power sources to connect.
• Check the recommended voltage for your particular DYNAMIXEL actuator before supplying power.

NOTES: 
• When using the terminal block, the left-side (near the barrel jack) is ground and right-side is source, so be 
careful of polarity when using an external power supply.
• Since the back of the board is exposed to several pins, it is recommended to use the provided supporters.

6. Connect the U2D2 to your computer via the provided USB cable. 

Micro-B USB port on U2D2
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The power LED light should illuminate on the U2D2. 

Status LED’s display status of the power supply, TxD(Data write) and RxD(Data Read)

7. Turn on the power switch on U2D2 Power Hub Board to supply power to the XM430-W210-R actuator. The 
red LED on the XM430-W210-R actuator will illuminate momentarily.

          

1.2 DYNAMIXEL WIZARD 2.0 INSTALLATION
DYNAMIXEL Wizard 2.0 is an optimized tool for managing DYNAMIXEL models from various operating systems. 
We will use this Windows version of the application for some initial configuration of the XM430-W210-R 
actuator. 

1. Download the Windows package of DYNAMIXEL Wizard 2.0. 

http://www.robotis.com/service/download.php?no=1670
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2. Click on the downloaded installation file and then click on the Next button to proceed with installation. Click 
Finish once completed. 

3. Open the Wizard 2.0 app. 

1.3 INITIAL ACTUATOR CONFIGURATION VIA WIZARD 2.0
1. Click on the Scan button in the DYNAMIXEL Wizard 2.0 software.  

NOTE: The first scan may take a few minutes as all available ports, baud rates, protocols and actuator ID’s 
are scanned. These settings can be adjusted for faster future scans by going to DYNAMIXEL Wizard  2.0 > 
Preferences > Scan (or click the Options icon near the Scan icon) and configure the options. 
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2. The detected DYNAMIXEL, in this case the XM430-W210-R, will be displayed in the left column.  Clicking on 
the actuator will reveal all actuator information in the center pane. Confirm the ID is 1. If not, click on the ID in 
the center pane and adjust to 1 in the lower right ID pane. Then click Save.

NOTE: If using multiple DYNAMIXELs, the ID numbers must be set to unique values. DYNAMIXELs sharing ID 
numbers with each other may result in communication errors. 

3. Click on the Baud Rate in the center pane and set to 1 Mbps in the lower right Baud Rate (Bus) pane. Then 
click Save.

NOTE: Baud rate for the XM430-W210-R must be 1 Mbps to communicate with Weigl hardware. 
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4. Click on the Operating Mode in the center pane and set to 3 Position Control in the lower right Operating 
Mode pane. Then click Save.

Position Control Operating Mode will provide a range of 0-360 degrees of rotation common to most animatronic 
joint applications. This range can be adjusted in Wizard 2.0. However, we will set minimum and maximum 
position limit later in the Weigl Hardware Configurator software where future adjustments are more easily 
performed once the actuator is connected to the Weigl ProCommander®. 

For reference, here are all possible operating modes for the XM430-W210-R actuator:

Value Operating Mode Description
0 Current Control Mode DYNAMIXEL only controls current(torque) regardless of speed and 

position. This mode is ideal for a gripper or a system that only uses 
current(torque) control or a system that has additional velocity/
position controllers.

1 Velocity Control Mode (Wheel) This mode controls velocity. This mode is identical to the Wheel 
Mode(endless) from AX series and MX series DYNAMIXEL.. This mode 
is ideal for wheel-type robots.

3 (default) Position Control Mode (Joint) This mode controls position. This mode is identical to the Joint Mode 
from AX series and MX series DYNAMIXEL models. Operating position 
range is limited by Max Position Limit(48) and Min Position Limit(52). 
This mode is ideal for articulated robots that each joint rotates less 
than 360 degrees.

4 Extended Position Control Mode (Multi-turn) This mode controls position. This mode is identical to the Multi-Turn 
Mode from AX series and MX series DYNAMIXEL models. 512 turns 
are supported(-256[rev] ~ 256[rev]). This mode is ideal for multi-turn 
wrists or conveyor systems or a system that requires an additional 
reduction gear.

5 Current-based Position Control Mode This mode controls both position and current(torque). Up to 512 
turns are supported(-256[rev] ~ 256[rev]). This mode is ideal for 
a system that requires both position and current control ,such as 
articulated robots or grippers.

16 PWM Control Mode (Voltage Control Mode) This mode directly controls PWM output. (Voltage Control Mode)
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5. By default, at initial setting of the Position Control Mode, the actuator range will be between 0 - 360 degrees. 
Let’s limit the max range to 50% for more common animatronic joint type movements such as an elbow or 
shoulder move. To do this, click on the Max Position Limit in the center pane and drag the red position indicator 
line in the lower right pane to a value of 2047. Note the new 180 degree range now indicated in the upper right 
pane. Click Save. 

6. Click on the Velocity Limit in the center pane. By default, this value will likely be 330. Let’s reduce this to 100 
by dragging the slider in the lower right pane and then clicking Save.
 

NOTE:  Max and Min Position, Velocity and Acceleration Limits, should always be set for all DYNAMIXEL actuators 
(when available, based on model) via the Wizard 2.0 software to ensure safe actuator position and speed limits 
during system restarts. See Section 3 , step 7 of this guide for further information and notes. 
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7. Test actuator movement by enabling the Torque toggle switch and clicking and dragging the red position 
indicator line. The actuator should move in relation to the position indicator movement.
 

8. Set the motor to the 0° position by clicking on the Goal Position in the center pane and then typing 0° in the 
field in the lower right Goal Position pane and hitting Return on the keyboard. 
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9. We are now ready to disconnect the motor and connect it to the ProCommander® AX. Click on the 
Disconnect button at the top of the screen. Then turn off the power switch on the U2D2 Power Hub Board. 
Disconnect the USB cable from the computer. 

NOTE: For most actuator settings, once the above basic configuration has been set, future adjustments can be 
done from the Weigl hardware and software as shown in the next steps, reducing the need to reconnect the 
actuator to the U2D2 interface and DYNAMIXEL Wizard 2.0 software. 
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2.1 PROCOMMANDER® AX RS-485 TO ACTUATOR
1. The XM430-W210-R actuator must now be wired to the RS-485 port 1 on the IX connector at the rear of the 
ProCommander® AX. An Industrial IX Type A to RJ45 cable such as this one from Mouser or similar is required. 
Cut the RJ45 plug off of the cable to wire to the actuator, or to further ease the wiring process, an IX to RJ45 
terminal block may be used, but is not required. The pinout of the RJ45 to the actuator is as follows:

PIN4: D- (485-)
PIN 3: D+ (485+)
PIN2: VDD
PIN1: GND

PIN1: GND 
PIN2: VDD 

PIN 3: D+ (485+)
PIN4: D- (485-)

NOTE: Once the initial actuator connection to the controller is configured, multiple DYNAMIXELs utilizing RS-485 
may be daisy-chained using ROBOTIS X4P cables.

For reference, IX to RJ45 pinout at the ProCommander® AX is as follows:

RS485-2 D- / DMX-IN/DMX-OUT

RS485-1 D- /  Servo-OUT (Dynamixel,....)

GND / CAN-GND

CAN-LOW

CAN-HIGH

RS485-2 D+ / DMX-IN/DMX-OUT

RS485-1 D+ /  Servo-OUT (Dynamixel,....)

GND / CAN-GND

PS-OUT +: 12V-24V*

PS-OUT +: 12V-24V*

5

4

3

2

1

6

7

8

9

10

*Power passed through from ProCommander power supply,
  96 watt max for both  PS-OUT + contacts

12345678

12345678

SH
IE

LD

NOTE: Only RS-485 port 1 of the ProCommander® AX can be utilized for communicating with RS-485 type 
DYNAMIXEL actuators. 

2. CONNECTING ACTUATOR TO PROCOMMANDER® AX

https://www.mouser.com/ProductDetail/HARTING/09482612749015?qs=Slt%252B5btlScTRUGbJZZ%2F%252B%252Bg%3D%3D
https://www.asi-ez.com/member/~16001.asp
https://www.asi-ez.com/member/~16001.asp
http://www.robotis.us/compare/385/383/382
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2.2 CONNECTING 12V POWER TO ACTUATOR
1. Connect a 12V power supply to the other side of the XM430-W210-R actuator connectors as shown below. 
The SMPS 12V 5A AC Adapter 12V power supply from the ROBOTIS DYNAMIXEL  Starter Set we utilized in 
Section 1 is acceptable for this. 

PIN4: D- (485-)
PIN 3: D+ (485+)
PIN2: VDD
PIN1: GND

PIN1: GND 
PIN2: VDD 

PIN 3: D+ (485+)
PIN4: D- (485-)

12V Power Supply
  -
  +

http://www.robotis.us/dynamixel-starter-set/
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1. Download the Weigl Hardware Configurator 1.25 or higher Windows version.

2. Connect the ProCommander® AX ethernet port 1 to your Windows computer via an ethernet cable. Be 
sure your computer is set to the same IP address subnet as the ProCommander® AX. The default, as shipped, 
IP address of Weigl ProCommander® devices is 10.0.0.101. Using this default IP address and assuming no 
other devices are connected to the network, your computer’s ethernet IP address could be set to 10.0.0.102. 
Subnet mask should be 255.255.255.0. To do this, click on the Windows menu > Settings > Network > Change 
Adapter Options > Ethernet > Properties and double click on Internet Protocol Version 4 (TCP/IPv4).  Click OK 
when complete. For further information regarding connecting to the ProCommander® AX, please refer to the 
ProCommander® AX manual. 

           

3. Power on the ProCommander® AX and the connected XM430-W210-R actuator. Then open the Weigl 
Hardware Configurator app.

3. CONFIGURATION VIA HARDWARE CONFIGURATOR

http://faq.weigl.support/support/solutions/articles/5000290557-weigl-configurator
http://faq.weigl.support/support/solutions/articles/12000050537-procommander-ax-instruction-manual
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4. From the Network Adapters dropdown menu, choose the network of your computer manually configured in 
the previous step. Then click the Begin Scan button. The ProCommander® AX should show up in the list. Double-
click on the ProCommander® AX.

5. Click on the Serial Ports tab. Then choose the DYNAMIXEL  XM-430 driver from the Serial Port 1 Driver 
Mode dropdown menu. Choose 1000000 for the Baud Rate and set the Max Number of Motors to 1. Click Save 
Changes at the lower left of the window. 

NOTES: 
• A baud rate of 1000000 must be used for Dynamixel RS-485 actuators to properly communicate with Weigl 
hardware. 
• DYNAMIXEL Wheel Mode is only used to engage/disengage the actuator for Velocity Control Operating Mode. 
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We are using Position Operation Mode for this example, so be sure Wheel Mode is not engaged. 
• If using multiple actuators, set the Max Number of Motors to the total number.

6. We will now quickly test the actuator. Click on the Analog/CAN Out tab. Click the Send Values checkbox to 
enable. The actuator should now move while dragging the slider between 0-10000 (0-100%). 

NOTE: A torque enable is not required once the XM430-W210-R actuator is connected to the ProCommander®. 
For DYNAMIXEL actuators, torque is automatically enabled upon power up of the ProCommander® AX and 
actuator. This can be controlled via Weigl WEM | Script™ commands, which is outlined later in this guide. 

7. The actuator should be moving between 0 - 180 degrees as the Output 1 slider is jogged between 0-10000 
(0-100%). Remember, the movement range was limited to 180 degrees in DYNAMIXEL Wizard 2.0 previously in 
this guide. 

Additional adjustments to the min and max range, as well inverting the motion, can be completed as outlined 
in the next section (or via the Control.INI as shown later in this guide), eliminating the need to reconnect the 
actuator to the U2D2 interface and DYNAMIXEL Wizard 2.0 app. However, please use caution in doing so, per 
the note below regarding actuator values set via Configurator. 

CAUTION: Any actuator settings revised within Configurator (or sent via the Control.INI as discussed later in this 
guide), will NOT be applied to the actuator until the ProCommander® is fully booted upon each power on. If, for 
example, a power shortage and sudden power up were to occur and the min and/or max position values are only 
stored on the ProCommander®; those ProCommander® values will be sent only, AFTER its boot-up sequence is 
complete. Otherwise, this may result in unnatural actuator movements for an animatronic armature during the 
2-3 second boot up sequence of the ProCommander®. For these reasons, it’s highly recommended any available 
max/min position, as well as velocity and acceleration limits for your particular DYNAMIXEL actuator(s), be set 
within DYNAMIXEL Wizard 2.0 before moving to Weigl software and hardware to avoid possible damage to 
actuators and/or animatronic armatures.
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8. For this guide, we will not further limit the max and min position here. However, for future reference, if you 
do decide to limit the movement range in Configurator, this is done by moving the slider to 50%, for example, 
and clicking the 10000 Set Max button. The max range would be reduced by an additional 50% in conjunction 
with any maximum position limits already set in DYNAMIXEL Wizard 2.0. The new setting would be immediately 
sent to the actuator when the Set Max button is clicked and reported in the Configurator status prompt window 
(Analog-Max 01: 5000 for our example). The motion can also be inverted via the Invert checkbox if desired.  

9. The Hardware Configurator app can now be closed. Next, we will build a show in ConductorPro™ 
incorporating the newly configured actuator. 
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4.1A CONDUCTORPRO™ PROJECT SET UP                                                                                                                                             
ConductorPro™ version 2020.1.27.5859 or higher with accompanying dongle must be purchased from Weigl 
and installed for the next steps. 

1. Launch ConductorPro™ and click on the  Devices tab and then the Discover Devices button. The connected 
ProCommander AX (with IP address 10.0.0.101) should be listed. Click on the ProCommander AX 10.0.0.101 to 
highlight. 

2. Right-click on the ProCommander AX and select Add to Timeline from the pop-up menu. A new timeline 
containing the ProCommander® AX will be created. 

4. CONDUCTORPRO™ INTEGRATION AND PROGRAMMING

https://www.weiglcontrols.com/products/conductorpro/
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3. Right-click on the ProCommander AX in the Layout tab and select Add Channel > Analog Channel from the 
pop-up menu.

NOTE: If multiple actuators have been configured in previous steps, they would be added here by clicking on 
Add Channel Range > Analog Channels and repeating the below step for each actuator, matching Analog/Servo 
Output to each actuator’s unique ID. 

4. Click on the newly created analog track and confirm the Device Address value of 1, which matches the ID of 
our XM430-W210-R actuator we set in DYNAMIXEL Wizard 2.0. Let’s test move the actuator by clicking on the 
Send Maximum Value icon at the top of the analog track. The actuator should move to the 180 degree max 
position limit we also set in DYNAMIXEL Wizard 2.0.

4.1B OPTIONAL - CONDUCTORPRO™ INPUT CONTROLLER                                                                                                                                   
While not necessary for this demonstration, an input device with analog functions can be added at this point 
to control the actuator for show programing, if desired. This could be any Windows-compatible USB HID input 
device including slider boards, joysticks, X-box controllers, etc.  A Logitech Extreme 3D Pro joystick is shown 
below for demonstration purposes. 

https://www.logitechg.com/en-us/products/gamepads/extreme-3d-pro-joystick.html
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1. Click on the Input Controllers tab and plug the USB input device into your computer. Click on the Device List 
Refresh icon. The connected device should be listed (in this case a Logitech Extreme 3D joystick). Click on the 
Show checkbox next to the joystick. 

Note: ConductorPro™ currently supports most Windows-compatible USB HID devices, as well as Behringer 
X-touch Universal Control Surfaces, Mackie devices and ArtNet input over ethernet. See the ConductorPro™ 
manual for more information.

http://faq.weigl.support/support/solutions/articles/5000290794-conductor-
http://faq.weigl.support/support/solutions/articles/5000290794-conductor-
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3. For this demonstration, the Y axis of our connected joystick will be used, so we will drag the Y axis from the 
Available Properties pane to the LogiTech Extreme 3D pane. Upon moving the joystick Y axis, both the Value(%) 
and the level indicator in the Tool Panel will display the joystick position in real time. The joystick Y axis has now 
been added to the project.

4. Click File>Save File to save your project to your computer before proceeding. 
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4.2 CONDUCTORPRO™ SHOW PROGRAMMING                                                                                                                                   
The actuator will now be added to a show timeline and movements programmed. 

1. Click on the Timeline tab. Then select the Freehand Curve Drawing Mode icon and sketch a curve on the 
data track. 
                

2. Return the playhead to 0:00 and hit the Space Bar to play the timeline and watch the actuator move to the 
curve in real time. From here, the curve can be redrawn, cut, copied and pasted as desired. See the next section 
for utilizing an input device for programming the movement cues in real time rather than drawing them. 

4.3 CONDUCTORPRO™ SHOW PROGRAMMING WITH OPTIONAL INPUT DEVICE                                                                                                                                   
1.Click on the Recording Groups tab at the bottom of the window and select the Configuration tab. Click on the 
Create New Recording Group icon to add a new recording group.

2. Click on the Create New Mapping icon and select our Logitech Extreme 3D for the Device, Y for the 
Property, and Record for the Action.  
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3. Click and drag the Analog Channel from the Layout tab to the Recording Target Channel.

 
4. Click on the View tab, select Recording Mode and click the Punch In button. The analog data track is now in 
record mode with our joystick Y axis mapped to the actuator.
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5. Hit the Space Bar to begin recording in real time. Move the joystick, which in turn will move the actuator and 
record the position cues on the timeline in real time. Hit the Space Bar to stop the playhead and then click the 
Punch Out button to stop the recording mode. 

 
6. To review the newly recorded output cues, drag the playhead before the recorded output cues and hit the 
Space Bar. The actuator will playback the data track movement cues in real time. 
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5.1 EXPORTING THE SHOW TO THE PROCOMMANDER® AX                                                                                                                                   

Once a show has been created, it can be deployed to files for playback on Weigl ProCommander® AX via a 
microSD card. We will create a show which auto plays and loops upon power up. 

1. Connect a microSD card reader to your computer and insert a microSD card. Be sure the card is formatted to 
FAT32 format. Right-click on the microSD card and select Format and choose Fat32 from the drop-down menu 
and Start. Once formatting is complete, the card will be ready for the show file deployment.  

 

2.Return to the ConductorPro™ and click on the Deployment tab and click the Create New Deployment icon. 
Give the deployment a name and save it to your computer. 

5. SHOW DEPLOYMENT
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3. To add our timeline to the deployment, click on the Add HFX File icon, navigate to your saved timeline hfx file 
and click Open. 

4. Click the Autostart and Loop checkboxes. This will automatically add WEM | Script™ code to our card files to 
boot the show upon ProCommander® AX power up and continuously loop. 

5. In the Deployment Targets section click on the Add Deployment Folder icon and select the microSD card for 
the show files to be saved to. Click the Select Folder button. 

NOTE: The Customize Control.ini Content, is where additional WEM | Script™ commands for monitoring 
and changing settings for the DYNAMIXEL actuators can be included. This will be discussed further in the 
following sections and can be added at anytime, but for now, we will export the show files for playback on the 
ProCommander® AX. 
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6. Click on Automatic and ensure all options except Deploy Additional Files are selected. Then click Deploy.

           

7. Once the deployment process is completed, a Deployment finished! message will appear in green. The show 
files have now been created and saved to the microSd card. 

8. ConductorPro™ can now be closed and the microSD card inserted into the ProCommander® AX for playback. 
The show should start immediately upon power up of the ProCommander® AX, with the XM430-W210-R 
actuator moving in sync to the playing show. The show will loop until the ProCommander® AX is powered off. 
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Most settings for DYNAMIXEL actuators can be monitored and modified on Weigl hardware and software via 
WEM | Script™ ASCII-based commands which are stored in the Control.INI text file of the show card files or 
sent directly from Weigl software. For additional explanation of the WEM | Script™ functionality, see the WEM 
| Script™ section of the Weigl website. Download the WEM | Script™ ASCII Sheet for a full list of available 
commands.

Below is a quick overview of some of the common DYNAMIXEL specific features and capabilities, related to the 
XM430-W210-R actuator. For other models and series actuators, refer to the control table for your model of 
DYNAMIXEL via the ROBOTIS website emanuals.

Other related notes:

•  Not all DYNAMIXEL models utilize the same control table. For example, XL430 models and XC430 models still 
belong to X-series, but lack the current-control features and operating modes offered by XM and XH models. 

• Another series of DYNAMIXEL which has been very popular for SFX/animatronics is the DYNAMIXEL P-series 
(industrialized models). These actuators have drastically different firmware addresses. 

CAUTION: Any actuator settings revised within Configurator (or sent via the Control.INI as discussed later in this 
guide), will NOT be applied to the actuator until the ProCommander® is fully booted upon each power on. If, for 
example, a power shortage and sudden power up were to occur and the min and/or max position values are only 
stored on the ProCommander®; those ProCommander® values will be sent only, AFTER its boot-up sequence is 
complete. Otherwise, this may result in unnatural actuator movements for an animatronic armature during the 
2-3 second boot up sequence of the ProCommander®. For these reasons, it’s highly recommended any available 
max/min position, as well as velocity and acceleration limits for your particular DYNAMIXEL actuator(s), be set 
within DYNAMIXEL Wizard 2.0 before moving to Weigl software and hardware to avoid possible damage to 
actuators and/or animatronic armatures.

6.1 ACCESSING DYNAMIXEL CONTROL TABLE SETTINGS                                                                                                                                 
Most aspects listed in the control table of the manuals for each specific DYNAMIXEL actuator can be accessed 
by Weigl hardware via the !adcX:Y.Z:A# WEM | Script™ command. For the specific control table data features 
available for the XM430-W210-R actuator used in this guide, see section 2 of the XM430-W210-R manual. 

The command structure is as follows:

!adcX:Y.Z=A#
X = actuator ID
Y= actuator control table data address*
Z = number of bytes related to the control data function*
A =actuator control table data range value*

*as defined in the control tables of the DYNAMIXEL manual for each specific actuator model

6. ADDITIONAL INFO - WEM | SCRIPT™ FUNCTIONALITY

https://www.weiglcontrols.com/wemscript/
https://www.weiglcontrols.com/wemscript/
http://faq.weigl.support/support/solutions/articles/12000048536-weigl-ascii-commands-download-latest-tool
http://emanual.robotis.com/docs/en/dxl/
http://emanual.robotis.com/docs/en/dxl/x/xm430-w210/#control-table
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For example, the LED light of the XM430-W210-R actuator used in this guide could be toggled on via the Weigl 
WEM | Script™ command !adc1:65.1=1#. With the actuator connected to the ProCommander®, this command 
could be tested by typing it in the console field and clicking Send via the Hardware Configurator app:

1 = actuator ID
65.1 = LED light control data address, 1 byte
1 = LED range value for on state

To incorporate this command into a show, it could be added to any ConductorPro™ timeline via a command 
channel marker or inserted directly into the Control.INI file in the Deployment tab by clicking the Customize 
Control.ini option and entering the command in the New pane as shown below:

NOTE: As included above, the command will turn on the actuator LED upon system power on and will remain 
illuminated until an actuator power off or an LED light off WEM | Script™ command sent via a ConductorPro™ 
show. 

http://emanual.robotis.com/docs/en/dxl/x/xm430-w210/#led65
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6.2 EEPROM VS. RAM CONTROL TABLE DATA SETTINGS                                                                                                                           
As outlined in the DYNAMIXEL actuator manuals, the Control Table is divided into 2 Areas - EEPROM and RAM. 
Data in the RAM Area is reset to initial values when actuator power is reset (volatile) while data in the EEPROM 
Area is maintained even when the actuator is powered off (non-volatile). Therefore, any RAM settings being sent 
via Weigl hardware must to be included in the Control.INI file to be initiated at each system power up.

NOTE: For any EEPROM control table data, the torque enable must be disabled first before sending the data 
change WEM | Script™ commands from Weigl hardware or software. Keep in mind, DYNAMIXEL actuator torque 
is auto-enabled upon power up the Weigl hardware. Therefore, the !adc1:64.1=0# WEM | Script™ command is 
required before any EEPROM control table data change commands are sent. 

!adc1:64.1=0#
1 = actuator ID
64.1 = torque enable control data address, 1 byte
0 = torque enable range value for off state

NOTE: Torque will need to be re-enabled after EEPROM control table data change commands are sent for the 
actuator to move again (!adc1:64.1=1#).

6.3 SUGGESTED INITIAL XM430-W210-R SETTINGS FOR SMOOTHER OPERATION                                                                                                                        
As a starting point for tweaking of actuator settings, some Weigl users have found the below control table 
data acceleration and velocity settings can provide smoother ramping/operation of the XM430-W210-R and 
other RS-485 X-series actuators in Position Operation Mode for an animatronic application. Since these are 
RAM settings (volatile), they will need to be set after each actuator power up. Therefore, the WEM | Script™ 
commands for these values should be included in the Control.INI as follows:

!adc2:108.4=95# //Profile acceleration value
!adc2:112.4=30000# //Profile Velocity value

In addition, the following control table data settings commands provide basic joint type actuator settings for 
the XM430-W210-R and other RS-485 X-series actuators in Extended Position Control Mode (Multi-turn) for an 
animatronic application. The commands to include in the Control.INI are as follows:

!esl1_16%50# //Set X-series servos to Default positions
!amt00011# //Activate multi-turn mode on elbow motors 
!amp4:7700# //Set R. Elbow max position
!amp5:7700# //Set L. Elbow max position

Further tweaking of control table data settings can be performed as needed for specific applications. Refer to 
the DYNAMIXEL  XM430-W210-R manual for available features, settings and value ranges. 

6.4 MONITORING CONTROL TABLE DATA SETTINGS                                                                                                                        
Weigl ProCommander® devices have the ability to monitor DYNAMIXEL actuator control table data and send the 
value of such data to a variable in the ProCommander®. The WEM | Script™ command for initiating monitoring 
of a specific control data function is as follows:
!arvX:Y.Z=V#

http://emanual.robotis.com/docs/en/dxl/x/xm430-w210/#torque-enable64
http://emanual.robotis.com/docs/en/dxl/x/xm430-w210/
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X = actuator ID
Y = actuator control table data address* 
Z = number of bytes related to the control data function*
V = number of the ProCommander® variable to which the values are to be assigned
Using a previous example of initiating the XM430-W210-R actuator LED light function, the status of the LED light 
can be assigned to a ProCommander® variable via the following command:

!arv1:65.1=1#

1 = actuator ID
65 = control table data address for actuator LED light
1 = number of bytes related to the control data function
1 = ProCommander® variable to which the LED light status values will be assigned

With the XM430-W210-R actuator connected to the ProCommander®, this command could be tested by typing 
it in the console field and clicking Send via the Hardware Configurator app. Next, click on the Variables tab 
and turn on Monitor Variables. Once the actuator LED is turned on (!adc1:65.1=1#), the value of variable 1 will 
reflect the value of the LED control table data function (Variable 1 = 1). 

Turning off the actuator LED light (!adc1:65.1=0#), will change the variable 1 value to 0. This can be verified by 
sending the !arvX:Y.Z=V# command again. 

NOTE: The !arvX:Y.Z=V# command is momentary only, meaning that the variable status is only updated each 
time the command is sent. 

The !arvX:Y.Z=V# command can be added to the Control.INI file to monitor any of the DYNAMIXEL control table 
data functions. 

For more specific information on ProCommander® variable functions, please refer to the ProCommander® 
manuals. 

Documentation, tutorials, and firmware updates for all Weigl products can be accessed via the Weigl Support 
and Solutions Center.

http://faq.weigl.support/support/solutions/folders/5000088849
http://faq.weigl.support/support/solutions/folders/5000088849
http://faq.weigl.support/support/home
http://faq.weigl.support/support/home


For more information, 
please see additional documentation at:

www.Robotis.com
www.Weiglcontrols.com

http://www.robotis.us/
http://www.Weiglcontrols.com

